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QUESTION 1

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. You want to get the
trend of the Business data range. For this purpose, you want to use trendlines in the chart. Which of the following steps
will you take to apply the trendlines in the chart? Each correct answer represents a part of the solution. Choose all that
apply. 

A. Clear the check box of any Trendline fields to disconnect a slicer. 

B. Select the type that you want from Trendline options. 

C. Click the Insert Trendline arrow, and then click Trendline Connections on the Options tab in the Sort and Filter
group. 

D. Select a chart and then navigate to the Chart Tools Layout tab. 

Correct Answer: DB 

 

QUESTION 2

You work as a Finance Manager for Blue Well Inc. The company has a Windows-based network. You are using Excel
spreadsheet for maintaining the financial budget and other financial calculations. You want to return the price per $100
face value of a security that pays interest at maturity. Which of the following financial functions will you use to
accomplish the task? 

A. PRICE function 

B. PPMT function 

C. PRICEMAT function 

D. PRICEDISC function 

Correct Answer: C 

Various financial functions (reference) are as follows: 

1.

 ACCRINT function: It is used to return the accrued interest for a security that pays periodic interest. 

2.

 ACCRINTM function: It is used to return the accrued interest for a security that pays interest at maturity. 

3.

 AMORDEGRC function: It is used to return the depreciation for each accounting period by using a depreciation
coefficient. 

4.

 COUPDAYBS function: It is used to return the number of days from the beginning of the coupon period to the
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settlement date. 

5.

 AMORLINC function: It is used to return the depreciation for each accounting period. 

6.

 COUPDAYS function: It is used to return the number of days in the coupon period containing the settlement date. 

7.

 COUPDAYSNC function: It is used to return the number of days from the settlement date to the next coupon date. 

8.

 COUPNCD function: It is used to return the next coupon date after the settlement date. 

9.

 COUPNUM function: It is used to return the number of coupons payable between the settlement date and maturity
date. 

10.

 COUPPCD function: It is used to return the previous coupon date before the settlement date. 

11.

 CUMIPMT function: It is used to return the cumulative interest paid between two periods. 

12.

 CUMPRINC function: It is used to return the cumulative principal paid on a loan between two periods. 

13.

 DB function: It is used to return the depreciation of an asset for a specified period by using the fixed- declining balance
method. 

14.

 DDB function: It is used to return the depreciation of an asset for a particular period by using the double-declining
balance method. 

15.

 DISC function: It is used to return the discount rate for a security. 

16.

 DOLLARDE function: It is used to convert a dollar price that is expressed as a fraction into a dollar price that is
expressed as a decimal number. 

17.

 DOLLARFR function: It is used to convert a dollar price that is expressed as a decimal number intoa dollar price that is
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expressed as a fraction. 

18.

 DURATION function: It is used to return the annual duration of a security with periodic interest payments. 

19.

 EFFECT function: It is used to return the effective annual interest rate. 

20.

 FV function: It is used to return the future value of an investment. 

21.

 FVSCHEDULE function: It is used to return the future value of a starting principal after applying a series of compound
interest rates. 

22.

 INTRATE function: It is used to return the interest rate for a fully invested security. 

23.

 IPMT function: It is used to return the interest payment for an investment for a specified period. 

24.

 IRR function: It is used to return the internal rate of return for a series of cash flows. 

25.

 ISPMT function: It is used to calculate the interest paid during a particular period of an investment. 

26.

 MDURATION function: It is used to return the Macauley modified duration for a security with an assumed par value of
$100. 

27.

 MIRR function: It is used to return the internal rate of return in which positive and negative cash flows are financed at
different rates. 

28.

 NOMINAL function: It is used to return the annual nominal interest rate. 

29.

 NPER function: It is used to return the number of periods for an investment. 

30.

 NPV function: It is used to return the net present value of an investment on the basis of a series of periodic cash flows
and a discount rate. 
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31.

 ODDFPRICE function: It is used to return the price per $100 face value of a security with an odd first period. 

32.

 ODDFYIELD function: It is used to return the yield of a security with an odd first period. 

33.

 ODDLPRICE function: It is used to return the price per $100 face value of a security with an odd last period. 

34.

 ODDLYIELD function: It is used to return the yield of a security with an odd last period. 

35.

 PMT function: It is used to return the periodic payment for an annuity. 

36.

 PPMT function: It is used to return the payment on the principal for an investment for a particular defined period. 

37.

 PRICE function: It is used to return the price per $100 face value of a security that pays periodic interest. 

38.

 PRICEDISC function: It is used to return the price per $100 face value of a discounted security. 

39.

 PRICEMAT function: It is used to return the price per $100 face value of a security that pays interest at maturity. 

40.

 PV function: It is used to return the current value of an investment. 

41.

 RATE function: It is use d to return the interest rate per period of an annuity. 

42.

 RECEIVED function: It is used to return the amount received at maturity for a fully invested security. 

43.

 SLN function: It is used to return the straight-line depreciation of an asset for one period. 

44.

 SYD function: It is used to return the sum-of-years\\' digits depreciation of an asset for a particular period. 

45.
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 TBILLEQ function: It is used to return the bond-equivalent yield for a Treasury bill. 

46.

 TBILLPRICE function: It is used to return the price per $100 face value for a Treasury bill. 

47.

 TBILLYIELD function: It is used to return the yield for a Treasury bill. 

48.

 VDB function: It is used to return the depreciation of an asset for a specified or partial period by using a declining
balance method. 

49.

 XIRR function: It is used to return the internal rate of return for a schedule of cash flows that is not necessarily periodic. 

50.

 XNPV function: It is used to return the net present value for a schedule of cash flows that is not necessarily periodic. 

51.

 YIELD function: It is used to return the yield on a security that pays periodic interest. 

52.

 YIELDDISC function: It is used to return the annual yield for a discounted security. 

53.

 YIELDMAT function: It is used to return the annual yield of a security that pays interest at maturity. 

 

QUESTION 3

You work as a Project Manager for Blue Well Inc. The company has a Windows-based network. 

You want to rename a worksheet as Important. 

Which of the following steps will you take to accomplish the task? Each correct answer represents a part of the solution.
Choose all that apply. 

A. Click the Insert tab and open the name sheet. 

B. Enter the name and click the OK button. 

C. Right-click on the Sheet tab and select the Rename option. 

D. Delete the old name, type the new name, and then click OK. 

Correct Answer: CB 
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QUESTION 4

You work as an Office Assistant for Tech Tree Inc. You have created a report in a workbook in Microsoft Excel 2010.
You have included various subtotals in a worksheet in the report to verify data accuracy. You want to remove all
subtotals from the sheet before you send it to your manager. 

Which of the following steps will you take to accomplish the task with the least administrative effort? 

A. Select all the subtotals. From the shortcut menu, click the Remove All Subtotals option. 

B. Hide the rows containing subtotals. 

C. Open the Subtotal dialog box by clicking the Subtotal option in the Outline group on the Data tab. Click the Remove
All button. 

D. Delete all the rows containing subtotals. 

Correct Answer: C 

According to the question, you have to remove all subtotals from the worksheet with the least administrative effort. You
can remove all subtotals from a worksheet at a time. For this, take the following steps: Open the Subtotal dialog box by
clicking the Subtotal option in the Outline group on the Data tab. Click the Remove All option. 

Answer option A is incorrect. No such option is provided in Excel 2010. 

Answer option B is incorrect. Although this will hide the rows containing the subtotals, the contents will remain there and

77-888 PDF Dumps | 77-888 VCE Dumps | 77-888 Study Guide                              7 / 10

https://www.lead4pass.com/77-888.html
https://www.lead4pass.com/77-888.html
https://www.lead4pass.com/77-888.html


https://www.lead4pass.com/77-888.html
2022 Latest lead4pass 77-888 PDF and VCE dumps Download

can be made visible by using the Unhide row option. Moreover, the question specifically specifies to remove all
subtotals from the sheet. Answer option D is incorrect. Although this step will accomplish the task, it will involve a lot of
administrative burden of selecting each row and deleting it manually. 

 

QUESTION 5

You work as an Office Assistant for Dreams Unlimited Inc. You use Microsoft Excel 2010 for creating various types of
reports. You have created a report in the format given below: 

In the A7 cell, you are required to put a formula so that it can fulfill the description provided in the B7 cell. Which of the
following formulas will provide the required result? 

A. COUNTIF(B2:C5,"=Yes") 

B. COUNTIFS(B2:C5,"=Yes") 

C. COUNTIF(B2:B5,"=Yes",C2:C5,"=Yes") 

D. COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes") 

Correct Answer: D 

In order to get the required result, you will have to insert the following formula in the B7 cell: 

COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes") 

Only Sarah and David have exceeded their January and February quotas, therefore the formula will provide 2 as the
result. 

Answer option C is incorrect. The COUNTIF function of Excel does not support multiple criteria. Answer options A and B
are incorrect. This formula will count all the cells that have the value "Yes" in the range B2:C5. As multiple criteria are
not 

applied in the formula, it will provide 6 as the result. In the A7 cell, you are required to put a formula so that it can fulfill
the description provided in the B7 cell. 

Which of the following formulas will provide the required result? A. COUNTIF(B2:C5,"=Yes") 

B. COUNTIFS(B2:C5,"=Yes") 

C. COUNTIF(B2:B5,"=Yes",C2:C5,"=Yes") 
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D. COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes") 

Answer: D 

In order to get the required result, you will have to insert the following formula in the B7 cell: 

COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes") 

Only Sarah and David have exceeded their January and February quotas, therefore the formula will provide 2 as the
result. 

Answer option C is incorrect. The COUNTIF function of Excel does not support multiple criteria. Answer options A and B
are incorrect. This formula will count all the cells that have the value "Yes" in the range B2:C5. As multiple criteria are
not 

applied in the formula, it will provide 6 as the result. 
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